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Introduction
Photoshop for the Web is a course created for the CAL PACT Web Design
Series to help participants learn features of Photoshop specific to web design. The
course covers simple introductory material and applies to both the Windows and
Macintosh computer platforms. This document serves as a supplement and future
reference to the class. Not all material in this documentation will be covered in the
class. Documentation for other classes in the Web Design series is available on
the CAL PACT website at http://calpact.berkeley.edu.

Skills you need for this course
• Text editing
• How to use the mouse
• Familiarity with the Windows or Mac operating systems
• Knowledge of internet basics, navigation, and search tools
• Solid understanding of the material covered in the HTML 1, 2, and 3

CAL PACT courses

Skills and concepts you will learn in this course
• What is Photoshop?
• Image Resolution
• Working with Colors
• Working with Layers
• Photoshop Tools and Palettes
• Graphic File Types (gif, jpg, etc.)
• Optimizing Images for the Web

Conventions used in this document
Menus and menu commands are separated by a vertical bar ( | ). In the document
they will appear as Menu|Command. An example of this is: “Select File|New...”

Use this
space for notes
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What is Photoshop?
Photoshop is one of the most popular image-editing programs.  Over time,
Photoshop has become a fully functional tool for producing and modifying images
for the web.

At first Photoshop may seem overwhelming, and to learn all of the features is well
out of the scope of this class.  However, we will cover the very basics of using
Photoshop and you will learn enough to prepare your images for the web, create
backgrounds and buttons.

What’s on the
Screen?
When you first open
Photoshop, the menu bar
at the top, the tool bar at
the left (with all the small
icons), and the palettes at
the right (with the slide
bars and tabs) appear in
the Photoshop window.
Each of these are
described further in this
class.  A summary of the
tool bar functions is
outlined in the Appendix of
this document.

Opening Files
To open a new file in
Photoshop, select
File|New on the menu
bar. When opening a
new file you will see the
following dialog box. In
the Name: box, enter a
name for your file.
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Resolution and Dimesions
Next select the dimensions and resolution for your image.  For the purpose of
creating a tiling background, we will use a width of 1024 and a height of 25 pixels.
This is substantially longer than the standard monitor size of 800x600, so the
image will continue to appear across the screen.
Resolution is the number of pixels per inch. In other words, the more pixels you
have per inch, the more detailed your work will appear.  If you are creating an
image for the web the standard resolution is 72 dpi (pixels per inch).  You can
always shrink your image later, but if you try to enlarge it, the image quality will be
compromised.  This is because by enlarging your image, you are increasing the
number of pixels in the image without specifying what they should look like.
Photoshop does it’s best and guesses that these additional pixels should have the
same colors as the ones they surround but often this results in a jagged image.
The Contents Box allows you to choose whether to have a White, Colored or
Transparent Background.  Generally, for creating background gifs, use the White
option.

Image Mode

After selecting OK from the menu, you will see a new box open up with the name of
your file.  The number in the % (50% in this example) is the amount the picture is
scaled and the letters in Parenthesis tells you the current color mode of the image.
RGB stands for Red Green Blue, which are the colors of light that the computer
monitor uses to display all colors.  Other modes are Grayscale and CMYK (Cyan
Magenta Yellow Black).  CMYK is used for print images.  They are the colors of the
inks that combine to form all colors.
To change the mode of your image go to Image|Mode and select the mode you
would like to use.  For web use, always begin your work in RGB.  When you have
finalized the look of your image, you can switch to indexed color mode, which has
a limited Palette of colors.   By choosing to finish your image in Indexed color you
can choose to use only web-safe colors and help minimize file sizes.

Choosing Colors
When creating images for the web, it’s important to use colors that will be
accessible to the most amount of browsers.  While newer computers often have
the ability to display millions of colors, older browsers may be using the standard
set of 256 colors.  To make sure your image looks good for the largest audience, it
is good practice to use Web Safe Colors.  These are a set of 216 Colors that the
majority of web browsers use.
Using Indexed Color
Photoshop 6 makes it very easy to select from web safe colors.  One method to
create a limited palette is to change the image mode to Indexed color.  When you
select Image|Mode|Indexed Color the following box will open up.

You may want to keep
copies of the orginal
image in its original
resolution in case you
modify or create new
images.

  Tip
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In the Palette Box, Use the down arrow at the
side of the box to select Web. Then click on
OK.
While you are in this mode, you will only be
able to choose from the 216 Web-safe colors.
However, if you need to change the image
size, be sure to change the mode back to
RGB, to prevent your image from looking
jagged.  Again, it’s usually best to start in RGB
mode and finish off with Index Color mode.

Using the Color Palette
On the right side of the Photoshop tool bar you should see the Color Palette.  If
you cannot find it, select Window|Show Color.

Before you begin selecting
colors, use the arrow to the
right of the Brushes tab to
change the setting of the
palette.  When Web Color
Sliders is checked, you will
be able to see the hex
values next to each of the
colors.  This is useful in
matching colors in your
image to hard-coded
colored elements in your
webpage.  Choose RGB
Spectrum to see the colors
available as seen on a
monitor.  Finally, check Make Ramp Web Safe to ensure that any color you chose
using the eyedropper tool will be a color that is web safe.

To see the currently selected color, look in the Color bar near the bottom of
the Toolbar.  To revert to the default colors (if you have chosen something
else) click on the small overlapping boxes in lower left corner.  These are
your foreground and background colors.  This doesn’t change anything on
your image until you apply these colors to your image with a tool.  The background
color is what your image will erase to if preserve transparency is on.  Otherwise,
you will erase to a transparent background.

For example, if you have selected pink as your background color, anything you
erase will be colored pink.  The foreground color is the color that will be displayed
when you use any of the fills, brush, text or other tools.
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A Brief talk about Layers
One feature of Photoshop is that you can use
multiple layers while working on your image.
Think of layers as transparencies stacked one on
top of another.  Each layer “stands alone”: if
different parts of your image are on separate
layers, any filters or changes you apply to one
layer won’t effect the other layers.  If you cannot
see the Layers Palette, choose Window|Show
Layers.  To create a new layer, select the Layers
tab and click on the arrow button at the right.
From this menu you can create a New Layer,
Duplicate a Layer, Delete an existing Layer or
otherwise manipulate the layers. You can also
access these features from the Layer menu (i.e. Layer|Delete Layer).

When you select to create a new layer, the message box shown below will appear.
Here you can name your new layer and choose the level of opacity.  If you choose
less than 100% opacity, you will be able to see other layers through the image on
that layer.
There are two more important aspects of the layers Palette.  The eye icon to the
left of each layer name tells you what layers are currently showing.  To “turn off” a
layer, click on the eye next to the layer you do not want to see.  The paintbrush
icon tells you what layer is currently editable.  Make sure you are editing the
correct layer!  Since you can see all the layers as if they are on the same level,
only the position of the paintbrush will tell you which parts of the image are currently
editable. You can change the layer order here by clicking on the layer name and
dragging to a new location.

Marquee, Fill, and Zoom Tools
(The Marquee, Fill and Zoom Tools are all found in the toolbar.)

The Marquee Tool is used to select a rectangular area of the image.  While
part of the image is selected, any changes will only affect that particular area.

You can see what area is selected by the Marquee or “marching ants”.  To deselect
an area, either click outside of it, or go to Select|Deselect. Also useful in the
Select menu is the Inverse option.  There are many other useful tools here, too!
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The Fill Tool fills a selected area with the solid color currently selected as the
foreground color.

The Zoom tool enlarges an area of the image.  When the zoom tool is in
enlarge mode, you will see a magnifying glass with a plus sign.  To Zoom

out, hold down the Alt button on your keyboard which will turn the “+” into a “-”.
Holding the button down, click the mouse on the area you would like to Zoom out
from. You can also use the menu bar and choose View|Zoom In / View|Zoom Out.
Always use the Zoom Tool when making detailed changes to your image.  You will
be able to make much more precise manipulations.

Creating solid color blocks for repeating backgrounds
First, turn the rulers on by going to View|Show Rulers.  The rulers should be
displayed around the edge of your image in pixels.  If they are not in pixels, double
click on any portion of the ruler and select Pixels from the Units box.
Zoom in to your image so the image is large enough to work with.
Choose the Marquee tool and select a box from the furthest left covering 150 pixels.
Choose the Color you would like to fill with.
Choose the Fill tool and click anywhere inside the selected area.

How to Undo
While using Photoshop, it can be very easy to invest a substantial amount of time in
creating or manipulating images. However, occasionally a misplaced cursor or an
unexpected result may happen.  Luckily the creators of Photoshop have provided
an Undo feature.  To undo your last action, simple type Ctrl+Z or select Edit|Undo.

The History Palette
The undo command is nice, but sometimes you may get yourself in a little bit
deeper trouble and need to “undo” much more than one step.  Enter the History
Palette, a feature first introduced in Photoshop 5.5.  This saves a version of your file
at every step, so if you don’t like the state your image is in now, you can time travel
back to when everything was on the right track.  To view the history palette, choose
Window|Show History.  You’ll see a list of all the changes you’ve made in your file.
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To delete an action you can click and drag the
action to the trash.  Another use of the History
Palette is to view your image in a different state.
To see how your image looked before the last
few actions, simply double click on one of the
actions in the list.  Keep in mind that you must
undo the actions in order.  Deleting an action will
also delete all of the actions that followed it.

Saving for the Web
Photoshop has a highly effective, built-in file
compression system.  When using images on
your web pages, it’s important to make the file sizes as small as possible so they
can load as quickly as possible.  If your image file sizes are too large, people
visiting your site might not want to wait for the images to appear.

Gifs vs. JPEG
In order to make image files smaller, two commonly used compressed files types
are used.   In general, save your file as a gif if you have line art, or have used very
few colors, and save your images as a jpeg if it is a photograph or very detailed
image.

Photoshop has a feature
to even further compress
your files.   To use this
feature go to File|Save
for Web.  If you are
asked to flatten layers
(and only if you won’t be
needing them again!)
choose Flatten Layers.

Select the 4-Up tab and
you will see four versions
of your image.  The
upper left hand corner
has your original image, along with the original file size.  (In this case 87.9K).  The
selected box is the optimized file (only 386 bytes).  There are also two other
options.  If the selected image looks okay and hasn’t lost too much of it’s detail,
choose OK, and you will be able to choose a name for your file that will have either
the .gif or .jpeg extension.

Note: When you save,  you are saving an optimized version of the file.  If you think
you might be editing the original image later, you can also save the non-web
optimized file as well.  This full sized version will still be present on your Photoshop
workspace when you exit the Save for Web window.

The History Palette is not
fail safe.  It is good, but not
perfect so save often.

 Warning

Flattening layers takes all
the layers you create and
permanently compacts
your image into a single
layer.  Make sure you keep
an unflattened copy of your
file if you ever plan on
working with the image
again.

  Caution
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Cropping Images
While you can create your own images in Photoshop, the program is often used to
manipulate already existing images.  To open up an image you have already saved
choose File|Open and select the location and file name of the file to open.

Cropping is an excellent way to reduce the size of image files by only
including the pertinent parts of the picture.  The Crop Tool is on the left of the

tool bar, towards the top.  Using this tool, draw a box around the area of the picture
you would like to keep.  You can use the handle boxes (the eight squares along the
dotted line) to change the selected area. When you are ready to crop, place the
cursor inside of the selected area and it will turn into an arrow head.  Double click to
crop the image.

Improving Image Quality and Resizing Images
Photoshop has thousands of tools professionals use to manipulate their images.
However, knowing just a few of these tools can make a huge difference in the
quality of your image.

Auto Levels
Some photographs may look murky or have a tint that makes the colors look slightly
off.  One quick way to correct some of the most common color problems is to
automatically adjust the levels of the red, green and blue channels. All you have to
do is select Image|Adjust|Auto Levels.  If you don’t like what the Auto Levels did to
your picture, you can always undo.

Unsharp Mask
To correct slightly blurry photographs, you can apply an Unsharp Mask filter.  Make
sure the layer holding your image is selected and select Filter|Sharpen|Unsharp
Mask.  The Unsharp Mask dialog box (shown on the next page) will appear and you
can adjust the sliders until the picture looks a little more sharp. You can apply the
filter multiple times to increase the sharpness.  The Unsharp Mask was applied to
the pictures on the next page with the settings shown to the right three separate
times.
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Resizing Images
In Photoshop, the most important thing to remember when you want to change the
image size is that unless you want your picture to look like abstract art, you can
only make the image smaller, not larger.

To resize an image, first
make sure the
Image|Mode is RGB.
Then go to Image|Image
Size to open up the
following dialog box.
Make sure that the
checkboxes for
Constrain Proportions
and for Resample Image
are checked.  You can
type in the new size
either in the box above
with the pixel dimensions
or the Print Size. When
you have finished select
OK to display your
picture again.  You can also use the Image Size dialog box to check on the file size
of your image or on the current dimensions of your work.

Using Text
In addition to creating and manipulating images, Photoshop also has a tool to add
text to your image.  The text tool in Version 6 has the added advantage of
automatically creating a new layer for each bit of text you add.  This is useful so you
can later add image effects to selected words and not the entire image.
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  To use the type tool, click on the T in the tool bar.  Your cursor will turn into the
text insertion cursor.  You should also see the toolbar shown below.  Here you can
select the font, size, formatting, color and other characteristics of your text (like
warping!).  Click on your image where you would like your text positioned and enter
the text. Don’t worry if it’s not in the exact place you would like it to be, you can
always move or delete the layer and try again.

Moving Tool

  To move items on a single layer, use the Move tool located in the Tool bar.  You
can either click and hold on the text you would like to move (first making sure you
are on the correct layer).  You can also use the arrow keys to more precisely
position text while the move tool is selected.

Layer Effects
Layer effects are similar to filters, but apply basic transformations to only the
current layer.  You cannot use Layer effects if your picture is on the background
layer.  To change the name of the layer go to Layer|Layer Options.

To use layer effects go to Layer|Layer Style or double-click the layer.  Drop
shadows and Glows are commonly used (perhaps over-used) for roll-over effects
or to highlight headings.  Before you apply any effects,
remember the purpose of what you are doing.  You want your
text to be readable. To the right is an example of applying Drop
Shadow and Emboss effects.

Shortcuts
As you become more proficient using Photoshop, you will find that keyboard
shortcuts save a considerable amount of time over using to mouse and menus.  In
the menus the shortcut commands are written out next to each of the commands.
For example you will see under the File menu that Save can also be invoked by
pressing down the Ctrl key plus the S key.

Other shortcuts in Photoshop don’t involve using the control key at all.  You can
access any of the tools in the tool bar by simply pressing the key letter on the
keyboard.  To find out a key word for a particular tool, hold the mouse over the tool
until you see the description.  This will tell you the name of the tool and give you it’s
access letter.  For example any time you want to Zoom, you can simply press Z on
the keyboard and the cursor will become the Zoom magnifying glass.

Learning More
This class only touches on a few of the many features in Photoshop.  The best way
to learn more is to use the program and not to be afraid to try new things.  There
are also many books on the topic and classes are offered on Photoshop through
UC Extension and other programs.
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APPENDIX
The Toolbar
The Toolbar contains the tools you will use to alter your images in Photoshop.  In
the case where there is more than one type of tool for a category, you can reach
the other tools by clicking and holding the mouse pointer on the icon.  Select the
proper tool and let go of the mouse button.

Selection Tools

a, b Elliptical and Rectangular Marquees
These tools allow you to select a rectangular or oval area

c, d Row and Column Marquees
These tools allow you to select an entire row or column of pixels

e Crop
Tool for selecting the part of an image you would like to retain and cropping
the rest.

  Magic Wand

Selects according to similar color.  Very helpful if you would like to select all areas
with the same color that are not connected.  To do this go to Select|Similar.

  Lasso

Allows you to make selections in irregular shapes.

  Move

Lets you move part of the image you’ve selected to another part of the canvas.  If
nothing is selected it will move the entire active layer.

  Airbrush

Allows you to airbrush over part of your image.  The slower you move it over the
image, the darker it paints.

  Paintbrush

Paints over your image.  Go to the toolbar at the top of the screen to choose
different sizes and the opacity of the paint.

  Rubber Stamp: Clone and Pattern
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First hold down Alt to choose the area to clone.  Then wherever you move the
cursor it will repeat the picture.

   History Brush

This works in conjunction with the History Palette. It allows you to erase back to an
earlier version of your work.

  Eraser

This will erase your screen to the color on the background.

  Blur (also Sharpen and Smudge)

Either blurs, sharpens or smudges portions of your image depending on which
specific tool is selected.

   Dodge (also Burn and Sponge)

Dodge (shown) lightens portions of your image.  Burn (looks like a hand making an
“O”) darkens portions of your image.  Sponge saturates or desaturates colors in
your image.

  Text

Used for adding text to your image. 

  Paintbucket (located under the Gradient tool)

Fills the selected portion of your image with the foreground color.

   Eyedropper

Allows you to set the foreground color to any selected color in the Color Palette or
in your image.

  Ruler (located under the Eyedropper)

Use with the Info Palette to help measure lengths and angles.

   Hand

You can use this tool to scroll and view areas of the image that don’t fit in the
window.

   Zoom Tool
Allows you to Zoom in to your image.  Hold down Alt key to Zoom Out.
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  Color Display

The square on top indicates the foreground color, the color your brush or text will
be.  The background color is the color you will erase to.  The arrows allow you to
reverse the foreground and background colors. Finally, the small boxes in the lower
left hand corner revert the foreground to black and background to white.

Appendix B
Examples Walkthrough

Creating a New File and Adding Background Colors

Files used: none.  You will use a new image file.

1.  From the File menu, select New.
2.  Select the width and height in pixels and a resolution of 72 pixels.
3.  Initally, select RGB for the Color Mode, but make sure you switch to Indexed

Color before saving.  (If you have multiple layers and plan to modify the file in the
future, DO NOT save the file once it is in Indexed Color mode.  Instead, select
Save for Web from the File menu.)

4.  In the Color Palette, open the menu and select the following:
Web Color Sliders
RGB Spectrum
Make Ramp Web Safe

5.  The Color Display will allow you to select and toggle between foreground and
background colors.  To select a color, use the Color tab with the slider bars,
enter in a hex code, or use the Swatches tab with the Eyedropper tool.

6.  Use the Fill tool to color the image you just created.
7.  Use the Selection tool to select an area of your image.  Drag out a rectangle

while holding down the mouse button, then add a second color by filling the
selection.

8.  To create a more subtle transition between your two colors, use the gradient
tool.  The gradient tool works by clicking on a starting point and dragging out a
line.  Colors will transition differently depending on how far out you stretch the
gradient marker and at what angle.

Text Tool, Zoom, Eraser, Move Tool and Layers

Files used: new image file from previous example

(before you start, make sure you are still in RGB mode)
1.  You can add text to your image by selecting the Text tool and clicking an area

within your image.  The Type Tool tool bar will appear, allowing you to select
font, style, size and color.  Adjust the settings, type in some text, and click OK.

2.  The text may not have been placed in the right position.  If so, use the Move tool
and then try to reposition the text.
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3.  You can also move the background.  If you look at the Layers tab, you will notice
that you have two layers (one for the background and one for the text.)  Think of
layers as different transparency sheets on a overhead projector.

4.  The tools will affect different areas of your image depending upon which layer
you have selected.  This is why only the text moved when you used the Move
Tool.  Try clicking on the other layer (your background color(s)) and using the
Move tool.

5.  Select the eraser and try to erase the background.  Try selecting various brush
types from the Brushes palette.  You may notice that you cannot delete the text
even if you select the layer.  The text layer is a special layer that will react
differently to tools than a normal layer would.

More on Layers, Magic Wand, Cropping, and Rubber Stamp

Files used: mountains, sky, and balloons

Now that you’ve had some practice with moving and layers, we’re going to practice
with them some more in additional learning about a few other useful tools.  The
goal of these exercises is to add different backgrounds to the balloon image using
two different approaches.
Method 1:
1.  Open the balloons.tif image from the File menu.

You’ll notice the layer is currently called Background.  This is the default state
for the image and prevents us from manipulating it, so we’ll need to copy the
layer and delete the original.

2.  Open the Layers menu and select Duplicate Layer.  In the new window, pick a
name for the layer and click OK.  (Note: names should be indicative of the
contents on the layer)

3.  You should have two identical layers.  To delete the orignal layer (Background),
select the layer and drag it on top of the trash can button located at the bottom
of the Layers window.  You can also right-click the layer and select Delete Layer.

4.  Now that we have a workable layer, the first thing we need to do is remove the
white background.  In order to isolate the white, we need to use the Magic
Wand.  The wand is similar to the selection tool in that it allows you to select/
isolate portions of your layer, but differs in that allows you to isolate non-
geometric areas by isolating colors.

Select the Magic Wand and click the background of the image.  You should notice
that it selects only the white background.  If it actually selects some of the balloons,
you may need to adjust the tolerance of the wand.  In the Navigator window, select
the Magic Wand Options tab.  Adjust the tolerance number between 0 and 255 and
click the background again.  The lower the number the less tolerant the wand
becomes.  (ie. using 255 would grab practically every color on the layer, whereas 0
would grab the specific color you select)
Now that you have the white background selected, hit Delete on your keyboard.
This strips out the white background.  You should now see a grey and white
checkerboard pattern which means you have a transparent area in your image.
This is what we want in order to add our background image as another layer
behind the balloons.
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5.  Open sky.tif image.  Select Select|All to grab and copy the entire image.  Then
select Edit|Copy.

6.  Toggle back to the balloons image and select Edit|Paste.
What happened to the balloons?  This is where the power of layers come into
play.  They sky layer became the topmost layer when we pasted it.  Since there
are no transparent areas in the background we can’t see the balloons.  This
isn’t a problem though because we can rearrange the layer order.

7.  In the Layers window, place your mouse on the name or thumbmail image for
the balloons image.  Click and drag it on top of the sky image layer above.
Voila!  You should be able to see the balloons with the new background.

Method 2:
1.  Rather than copying and pasting an image, you may only want to copy certain

areas or duplicate the same section of an image.  This time, we’ll use the
Rubber Stamp tool to add a different background.
First, create a new layer in the baloons image by opening the Layers window
menu and selecting New Layer...

2.  Use the File menu and open the mountains.tif image.
3.  Select the Rubber Stamp Tool.  Now we have to tell PhotoShop where to start

copying the image from, so hold down the Alt key and click in the bottom left
corner of the background.

4.  Go back to the balloons image.  Make sure the new blank layer and Rubber
Stamp Tool are selected and paint in the background by clicking and dragging
the mouse across the screen.  You can also adjust how much of the
background is copied by selecting the proper size in the Brushes window.

5.  If the mountain background didn’t copy over in the position you want, select the
Move Tools and readjust the position of the layer.

6.  Finally, if you would like to tighten the image up, use the Cropping Tool.  This will
allow you to cut down the dimensions of your image without resizing it. Click
and drag a rectangle on your picture.  Readjust the size by using the resizing
handles and hit Enter.  Whatever is inside of the rectangle will be retained after
the crop.

Saving Files for the Web

Now that you’re done with the image, you’ll need to decide which layer to keep and
save it in a format that can be read by a web browser.  If the image is line art or 2
dimensional, you’ll want to save it as a .gif.  On the other hand, if it’s something like
a photograph you’ll want to save the image as a .jpg.  In either case, the image you
just created will need to be converted to one of the types.
1.  Use File|Save for Web.

This will open a new window.  Selecting 4-Up will show various samples of your
picture.  Each sample will vary in picture quality and size.

2.  Select GIF or JPEG from the pull down menu.
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3.  Click the sample you want and click OK.
4.  A new window will pop up allowing you to change the name and location for the

converted file.  Don’t worry.  The original file will not be replaced.
Now you have two copies of your image, the original psd (Photoshop file) and
your converted one (gif or jpg).

Flattening Layers

Files used: previous image with balloons, clouds, and mountains

One other trick with layers is that you can flatten them.  Why would you want to
flatten layers?  Your image may have tons of layers, many of which could just as
easily be combined into a single layer.
Also, keep in mind that you may want to save the psd (Photoshop file with layers) if
you plan on altering the image in the future.  As a general tip, always save two
copies of your image (the original psd file with layers and a flattened .gif or .jpg)
You’ll have three options when you merge layers together: Merge Down, Merge
Visible, and Flatten Image.
Merge Linked
This will merge the selected layer plus any layer(s) that are linked to it.  Use the
blank box next to the eye in the layers window to link layers.  Then use the Layers
menu to select Merge Linked.
Merge Visible
This will merge all visible layers.  Use the Layers menu and select Merge Visible.
Flatten Image
This will merge all layers regardless of whether they are linked or not showing.  If
there are layers not showing, you will be asked whether to discard them or not.
Select Flatten Image from the Layers menu.

Using Undo, History, Adjust Settings and Filters

Files used:  corks

The nice features of Photoshop allow you to undo previous performed actions.  The
easiest way to undo is to select Edit|Undo <action>.  This is a convenient way to
undo the very last action performed.
You may run into a situation where you merged a few layers together and need to
undo them.  The only thing is, that was ten actions ago!  Uh oh.  Not a problem.
The History palette stores all of the actions performed while the file is opened.
Scroll up and down on the list until you find the action you want to undo.  When
you click on the action, all previous actions up to the one you selected will be
undone.  If you decide you don’t want to go back or that far back, select a more
recent action from the list.  Nothing will be permanent until you perform a new
action.
Let’s try this function out along with some tools to clean up your pictures.
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1.  Open the file named cork.jpg.
2.  Hmm.  This looks a little blurry and the colors are slightly off.  Let’s start off by

adjusting the color.  Select  Image|Adjust|Auto Levels.
3.  Now for the blurry part.  Photoshop has many built-in filters to use on your

image.  To start, select Filter|Sharpen|Unsharp Mask.
4.  Much better.  Now go ahead and try some of the other filters out.  You’ll notice if

you are working with mulitple layers, filters will only affect the selected layer.
5.  If you don’t like one of your changes, use the History tab to back up a few steps.

Final Recap

Files used:  Bear, Bear Arm, and Guitar

Take a guess as to what we’re doing now?  We’re going to use the three images to
make the bear look like it’s playing the guitar.  Take about 15 minutes or so using
the skills learned in class to make the bear play the guitar.  This is your time to test
the features you’ve learned on your own.  And one last thing, don’t worry if you
accomplish the job in a completely different way than what the instructor does.
Photoshop is not an exact science.  The end result can be achieved in a myriad of
ways, none of which is the correct way.


